
MLA Style: Citing Sources and Formatting 
Not only does a good research paper include thorough research and thoughtful analysis, it follows specific 
rules for citing sources and formatting. This brief guide will illustrate how to correctly reference your 
sources and set up your paper. 

Connections Education® students should use Modern Language Association (MLA) style for citing 
sources and formatting. MLA style is commonly used in many middle and high schools as well as in 
colleges and universities across the country. 

The MLA publishes the MLA Handbook for Writers of Research Papers. This is a very useful book, as it 
goes into great depth explaining the steps for writing a paper. The book is available at most bookstores, 
and your local library likely has copies. If you run into an issue, such as citing a source that is not covered 
in this guide, it is best to find the proper way of citing your source by consulting the MLA Handbook or 
by asking your teacher. 

This guide covers the basics for formatting and citing sources. However, always follow the specific 
guidelines presented by your teacher. For instance, if you want to incorporate pictures or other images 
into your paper, ask your teacher about the best way to do this. Depending on your teacher’s preference, 
images could be included within the body of the paper or in an appendix. 

Formatting Your Paper1

All formatting instructions provided are for use with Microsoft® Word 2007. 

Here are some basic steps for setting up your paper. 

1. Paper Size and Margins – Your paper should be set to 8.5 inches by 11 inches. This is standard letter
format. Your page margins should be set at 1 inch on all sides.

To set your margins: Select the Page Layout tab, and then select the Margins drop-down menu. Set the top, bottom,
left, and right margins at 1 inch.

To set your paper size: Select Page Layout tab, and then select the Size drop-down menu. Set the paper size to 
Letter. (This should be the default setting, so this step may not be necessary.)

2. Fonts and Font Size – Choose a font and size that is easy to read—Times New Roman and Courier
are preferred. Use a 12 point font size. The text color should always be black when writing research
papers and formal essays.

Courier 12 Times New Roman 12

3. Punctuation and Spacing – Use only one space after periods and punctuation marks, and double- 
space the lines in your paper. This makes it easier to read and allows your teacher to easily add 
notes, comments, and feedback. When you review your drafts, you can also use this extra space to 
write notes for revisions and edits. Your text, with the exception of the title of your paper, should be 
aligned to the left. Also make sure to indent the first line of all paragraphs by one-half inch. You can 
do this by pressing the Tab key.

1 
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To set your paper for double-spacing: Select Paragraph from the Home tab. In the spacing section, select Double 
from the Line spacing drop-down menu. If you have already written parts of your paper, you will need to select all 
text before changing the spacing. You can select all text by pressing Ctrl+A. 

4. Headers and Page Numbers – On the top right of your paper, you should have a header (text at the
top of the page) that includes your last name and the page number. You can use the Header and
Footer function to automatically place this on all your pages.

To set your header: Select Page Number from the Header & Footer section of the Insert tab. Choose Top of Page
from the drop-down menu, and select the option that aligns the page number on the right. Then type your last name,
and add a space before the number. Close the header and footer view. Your header will now carry throughout the 
document as you type. If you need to edit this information later, choose Header from the Header & Footer section.

5. Italics and Underlining – Titles of books, plays, magazines, newspapers, and many other works
should be italicized or underlined. Note that italicizing is more common today than underlining, as
underlining was easier to do in the days when typewriters were used.

6. Formatting the First Page –

The top four lines of your paper should have your 
name, your teacher’s name, your course, and the 
date you turn in your paper. 

Chan 1 

Katie Chan 

Mr. Jackson 

English 9 

3 May, 2011 
Only the title of your paper should be centered.

Alternative Fuel Sources for AutomobilesIndent the 
first line of all 
paragraphs 
one-half inch.

Make sure 
the text is 
aligned left.

Margins 
should 
be set at 
1 inch. 
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Today more than ever, people are looking to scientists and engineers 

to find new ways to power our cars and trucks. Rising oil prices, due to 

instability in the Middle East and an aging fuel refining infrastructure, and 

environmental concerns are causing drivers to look at the possibility of driving 

cars powered by sources other than oil. There are several sources to consider, 

ranging from hydrogen to fuels from . . . 



Citing Sources: What Is the Purpose?
It is extremely important that you cite, or identify, the sources you used to write your paper. If you do not 
cite your sources, it could be considered plagiarism. In general, plagiarism occurs when someone uses 
another person’s words, products, or ideas without properly acknowledging the original work and with 
the intention of passing it off as his or her own. The simplest form of plagiarism is copying someone 
else’s words and passing them off as your own. Another form is using another person’s ideas and 
claiming them as your own. By properly citing your sources, you will avoid plagiarism. 

This document provides an introduction to formatting and citing sources. Click on the link below to 
access the Purdue Online Writing Lab website to review MLA style in more depth, including how to cite 
source types not covered in this document. 

Purdue Online Writing Lab 

Citing Sources in Your Paper
There are two important steps to correctly site sources for your paper. The first step is citing the source 
within your paper. For this, MLA recommends using parenthetical citation. 

Below is a passage from a book about running cars on vegetable oil by Michele Anthony.

Does the car in front of yours smell like a deep fryer? It’s probably a diesel that has 
been converted to run on vegetable oil. Many people are buying old diesel cars at a 
bargain and then converting them. Not only does making the switch reduce the CO2 

in the atmosphere, it allows drivers to run their vehicles virtually for free—assuming 
they recycle used oil from restaurants. But read closely. It takes a moderate amount 
of patience and know-how to convert your car smoothly and safely. 

From this passage, the following sentence for the research paper is derived.

Converting a diesel engine reduces CO2 and allows drivers to run their vehicles for 

free (Anthony 12). It takes . . .

Anthony is the author. The passage is on p. 12 of her book.

At the end of the paper’s sentence, which is a summary of Anthony’s passage, the author’s last name and 
the page number the passage was found on is placed in parentheses. 

There are some additional styles of parenthetical citation which are considered correct. If you used the 
author’s name in the sentence, you can cite just the page number. 

While Anthony highlights the benefits, she notes that the conversion “requires a 

moderate amount of patience and know-how” (12). Since the author’s name is mentioned, 
just the page reference is necessary. 
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Using Quotations in Your Paper 

Sometimes, it may be unclear how to appropriately cite a work in your paper, such as when an article 
does not have an author listed. Below are some examples for more complex citations. 

Citing Works When You Don’t Know the Author – Use the title of the work. You can shorten the title 
if it’s very long. Suppose you cite an editorial on page A8 in a newspaper titled “Why Light Rail Is Good 
For Everyone.” The editorial does not include the author’s name. 

The benefits of publ ic transportation—including the proposed light rail system— 

reach not just to those who cannot afford cars, but even to 

those at the highest income levels in the community (“Why Light Rail” A8). 

No author is listed, 
so the article title 
is used. The title 
of the article has 
been shortened. 

Using More Than One Book from the Same Author – You can also use the title of the work when you 
are citing more than one source from a specific author. If you are citing both Anthony’s article “Free 
Ride” and her book Greening Your Life, use the names in your parenthetical citations. 

Citing Two Authors with the Same Last Name – Use the author’s first initial with the last name. 

Some scientists believe that we are at a significant crossroads in the development 

of new fuel sources (A. Peterson 98). Some say creating new sources could cause a 

“disastrous rise” in the cost of living (Q. Peterson 24).

Citing Websites – Since websites don’t use page numbers, just use the name of the webpage or web 
article title in the parenthetical notation. The following example uses a source from Grolier™ Online. In 
this instance, no author is cited, so the name of the article is used. Always use the author’s name if it is 
listed. 

According to experts, by the end of the 21st century, energy trends will shift away 

from fossil fuels toward alternative sources. Coal, currently the most abundant fuel, 

will likely run out in 250 years (“Energy”).

As with a print source, if you use the wording of the source, surround those words with quotation marks. 

According to the author, Earth is “slowly running out of gas as it speeds down the 

road” (“Energy”). 
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Sometimes you may want to include a long quotation. Note that quotations four lines or longer will 
require special formatting. 

The argument for continuing to develop initiatives for offshore wind power is 

clear: 
Since the quotation is specially formatted, 
quotation marks are not needed. 

The quotation is indented one inch from the left margin. 

Wind is a clean and renewable energy source that can have a tremendous 

impact on energy use nationwide. The economical effects are clear and 

immediate: adoption of wind power will stabilize prices for consumers and 

reduce the overwhelming but often hidden cost of gas emissions 

(Weingarten 22). 

Citing Sources in a Works Cited Page 
You’ve learned that citing sources within your paper is very important. It is just as important to create a 
Works Cited page (sometimes known as a bibliography). The Works Cited page provides detailed 
information about the sources you used in your paper. Here you will list a complete citation for all of the 
books, magazines, encyclopedias, and websites you used. 

A citation often contains the following information: the author, the work’s title, city of publ ication, date 
of publication, and medium of publication. Various types of publications (both print and online) have 
slightly different formats. Specific information about publishing, such as the city of publication and the 
name of the publisher, can usually be found on the first few pages of a book or magazine. 

A guide to some of the most common types of citations is listed below. 

Book Citations 

Book by One Author 

author’s last and first 
names followed by a 
period 

Anthony, Michele. 

book title followed 
by a period 

Greening Your Life. 

city of publication followed by a colon, 
name of publishing company followed by 
a comma, year published followed by a 
comma, and format followed by a period 

New York: Faraway Press,

2006. Print.

© 2011 Connections Education LLC. All rights reserved.



Book by More Than One Author 

Use the order in which the authors appear on the book title; only the first author should be written with 
last name first. 

Vinson, Juanita, and Mary Robertson. Texas and the Great 

Depression. Houston: Texas Press, 2004. Print. 

Book by More Than Three Authors 

If there are more than three authors, list the first author followed by the term et al. 

The term et al. is an abbreviation for a Latin term meaning 
“and others.” 

McCartney, Jessie, et al. Oil Addicts. London: Split Atom Press, 

2008. Print. 

Book by a Corporation, Committee, or Group (No Author Specified) 

West Virginia Heritage Association. Coal and Its History. 

Morgantown: West Virginia University Press, 2002. Print. 

Encyclopedia Citations 

Encyclopedia Article with an Author 

article title followed by period 
and in quotation marks 

Model, Adam. “Carbon.” 

For reference works, note the edition. If no edition is 
given, use the year of publication as the edition (e.g., 
2005 ed.). 

Encyclopedia Examplica. 21st ed. 1999. 

Print. 

Encyclopedia Article without an Author 

If you reference a definition from a dictionary, use the citation for an encyclopedia article with no 
author. 

“Carbon.” Encyclopedia Examplica. 21st ed. 1999. Print. 
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Magazine and Newspaper Citations 

Newspaper Article 

If more than one author, follow the style for books with more than one author.

Acosta, Lydia. “New Fuels Come to Springfield.” Springfield 

Telegram 16 Aug. 2006: A4-A5. Print. 

 

Newspaper Editorial 

For editorials, add the word Editorial followed 
by a period. If you reference a letter to the 
editor, add the word letter followed by a 
period. 

“Why Light Rail Is Good For Everyone.” Editorial. Springfield 

Telegram 12 Dec. 2005: A8. Print. 

Magazine Article 

Anthony, Michele. “Free Ride.” Outside the Lines Mar. 2010: 12– 

16. Print.

Website Citations 

Basic Website Citation 

If no author is given, start with 
the name of the article. Always list 
an author if one is given.

“Alternative Energy Sources.” 

name of the website (italicized) 

The New Book of Popular Science.

name of the organization 
that sponsors the website 
and date of electronic 
publication 

Grolier Online, 2011. Web. 

date the site 
was viewed 

11 April 2011. 

 

MLA no longer requires the URL in Works Cited 
page entries. However, if your instructor would like 
the URL included, MLA suggests placing it in carats 
after the access date. If you must break the URL 
over a line, do so only after a slash mark. 

<Website URL goes 

here>.
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Helpful Hints for Web Citations
It is extremely important that you note the day you accessed the website as websites can
change from day to day.
MLA no longer requires URLs in Works Cited page entries. However, ask your teacher
if you should include this information. If you do include the URL, add it in angle
brackets after the access date.
Use n.p. if no publisher is provided. Use n.d. if no publication date is provided. Use n.
pag. if an entry requires a page number, but none is available in the source (e.g., online
journal).

Other Citations
Personal Interview

Include the name of the person interviewed, followed by a period. Then add the words 
“Personal Interview” followed by a period. End with the date the interview occurred. 

Bashir, Jules. Personal Interview. 8 Feb. 2007.

Scholarly Journal

For illustrative purposes, the components of the journal citation are listed above 
instead of an example. Always include the issue number if available. Consult with your 
teacher if you have questions about how to use or cite scholarly journals. 

Author(s). “Article Title.” Journal Title. Volume. Issue (Year): 

pages. Medium.

Works of Art

Name the artist, followed by the title of the artwork in italics. Add the date if available, 
and use n.d. if unknown. Last, include the name and location where artwork is kept. 

Maya, Jamille. The Beginning of the End. 1972. Museum of Paris, 

Paris.

TV or Radio Program

Name the episode in quotation marks. Then add the
program name in italics. Include the network name, station 
call letters, city, and broadcast date. Finally, add the 
medium (television or radio). 

“Day at the Garbage Dump.” Fuel Hunter. WTH. WALT, Kansas City. 

15 April 2011. Television.
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Formatting Your Works Cited Page
The Works Cited page follows the last page of your research paper. The margins, double-spacing, and 
header are the same for your paper as for the Works Cited page, so you will not have to reformat this 
page. The page’s title, “Works Cited,” should be centered on the top line of your page. You do not need 
to put extra line spaces between your sources. However, you will need to indent the second (and any 
additional) lines of your source.

Note: Three hyphens may be used in a Works Cited list when an entry begins with the same author name 
in the same order as the previous entry. 

The following Works Cited page is based on the sources referenced in the various passages and examples 
noted in this guide.2

2 With the exception of the Grolier Online™ article, the sources in this document are fictional. For illustrative purposes, the 
author of the Grolier Online article was omitted. The author is William J. Cromie. 
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	• MLA no longer requires URLs in Works Cited page entries. However, ask your teacher if you should include this information. If you do include the URL, add it in angle brackets after the access date.
	• Use n.p. if no publisher is provided. Use n.d. if no publication date is provided. Use n. pag. if an entry requires a page number, but none is available in the source (e.g., online journal).
	Other Citations
	Personal Interview
	Bashir, Jules. Personal Interview. 8 Feb. 2007.
	Include the name of the person interviewed, followed by a period. Then add the words
	“Personal Interview” followed by a period. End with the date the interview occurred.
	Scholarly Journal
	Author(s). “Article Title.” Journal Title. Volume. Issue (Year):
	pages. Medium.
	For illustrative purposes, the components of the journal citation are listed above
	instead of an example. Always include the issue number if available. Consult with your teacher if you have questions about how to use or cite scholarly journals.
	Works of Art
	Maya, Jamille. The Beginning of the End. 1972. Museum of Paris, Paris.
	Name the artist, followed by the title of the artwork in italics. Add the date if available, and use n.d. if unknown. Last, include the name and location where artwork is kept.
	TV or Radio Program
	“Day at the Garbage Dump.” Fuel Hunter. WTH. WALT, Kansas City.
	15 April 2011. Television.
	Name the episode in quotation marks. Then add the program name in italics. Include the network name, station call letters, city, and broadcast date. Finally, add the medium (television or radio).
	Formatting Your Works Cited Page
	The Works Cited page follows the last page of your research paper. The margins, double-spacing, and header are the same for your paper as for the Works Cited page, so you will not have to reformat this
	page. The page’s title, “Works Cited,” should be centered on the top line of your page. You do not need to put extra line spaces between your sources. However, you will need to indent the second (and any additional) lines of your source.
	Note: Three hyphens may be used in a Works Cited list when an entry begins with the same author name in the same order as the previous entry.
	The following Works Cited page is based on the sources referenced in the various passages and examples noted in this guide.2
	2 With the exception of the Grolier Online™ article, the sources in this document are fictional. For illustrative purposes, the author of the Grolier Online article was omitted. The author is William J. Cromie.
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